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5.0 INTRODUCTION TO THE SYSTEM SOFTWARE

The BioLogic Duo-Flow system software is based on Microsoft Windows®, a widely used operating system
for PC-compatible computers. This chapter discusses how to use the BioLogic Duo-Flow system software.

5.1 USING THE SYSTEM INTERFACE

The Manual control screen (Figure 5-1) is the first screen displayed when you turn on the system. This
screen, like all BioLogic screens, is grouped into the Main (or System) Menus, the System Control Window,
and the System Status Bar. The contents of the System Control Window are discussed in Chapters 6 and 7
and in the separate documentation for the Econo Gradient Pump (EGP) and the QuadTec UV/VIS Detector.

• Browser screen: Chapter 6
• Manual Control screen: Chapter 7, section 7.1
• Setup screen: Chapter 7, section 7.2
• Protocol screen: Chapter 7, section 7.3
• Run screen: Chapter 7, section 7.4
• Post-Run screen: Chapter 7, section 7.5

Figure 5-1. Layout of the Screen Display, showing the Manual Control Screen
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The BioLogic Duo-Flow system is controlled and monitored using the following:

• System Toolbar: This toolbar is the primary navigation tool for the system software.

• System drop-down menus: These menus are always displayed. Access to advanced functions are
found only in the drop-down menus. Note: Some functions found on the System Toolbar are
duplicated in the drop-down menus.

• System Status bar: This area shows information about components in the system, as well as
providing information about software icons.

Note: Items shown in gray are not currently active.

5.2 STANDARD MOUSE AND KEYBOARD FUNCTIONS

The BioLogic Duo-Flow system is supplied with a standard PC-compatible mouse and keyboard. The left
mouse button is used with system software, except as noted.

Table 5-1.
Special Function Keys

Special Function Description
Keys

Hold until Keypress: This is used during a run to advance the Method (i.e.,
satisfy the Hold) when the Method includes a “Hold until Keypress” step.

Help: Displays the Help menu for the currently displayed screen.

Esc: Functions as an alternative to the Cancel selection in a Dialog box.

Alt: Some system commands can be executed either by selecting them from a
drop-down menu or by holding down the Alt key and then pressing the
appropriate character key.
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5.3 SYSTEM MENUS

The system menus consist of both System drop-down menus and the System Toolbar. In some cases,
identical functions are found in both areas. Advanced features are located only in the System drop-down
menu.

5.3.1 System Toolbar Buttons

Most of the System Toolbar buttons are continuously displayed across the screen. The function of each
toolbar button is provided in Table 5-2.

Table 5-2.
Toolbar Buttons

Button Description

File Buttons Note: Similar functions can be found by selecting the File drop-down menu.

Initiates the process of writing a new method. The new method will be saved into
the currently open User and Project directories, which are listed in the window title
bar. Note: To place a new method in a different user and project directory, choose
Select User and Project under the File menu before clicking on the New Method
icon in the Toolbar. Choose the desired user and project from the appropriate
drop-down list.

This button is available when an open method has runs associated with it. It
allows you to create a new method based on editing the open method. A copy of
the open method is made, and the system software prompts you for a name
change.

Initiates a new run for the currently open method. You will be prompted for a new
run name prior to launching the run, or the runs will be numbered consecutively.

Opens the database of existing users, projects, methods, and runs for creating
new users and projects. See chapter 6 for a complete description of the browser.

Allows you to define when to print and what is to be printed in the report for a run.
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Table 5-2. (continued)
Toolbar Buttons

Button Description

View Buttons Note: Similar functions can be found by selecting the View drop-down menu.

Displays the Manual screen, which allows individual control of instruments and
devices in the system. In Manual mode, data can be viewed but it cannot be
saved.

Displays the Method Setup screen for specifying the components required for your
method. From the Setup screen you can add a descriptive name to the valve
positions and buffers. This screen is automatically displayed after the New Method
button is selected.

Displays the Protocol screen for creating and editing a method.

Displays the Run screen, from which you can initiate a run of the currently loaded
method. You will be prompted for a new run name prior to launching the run.

The notes section is a prompted section which allows you to enter additional
information about your method and/or run. This section is always editable, even
after a run is executed.

PostRun allows you to customize your chromatogram prior to printing.

As the run progresses, all events are recorded in the Log. This information cannot
be edited. This button is not displayed when the EzLogic integration software is
installed. To view the Log, select Run Log from the View drop-down menu.

Appears only when the EZLogic integration software option is installed; this button
replaces the Log button. It launches the software.

Enables the selection of up to 8 instrument traces to display on screen and on the
printed report. The trace options are : standard UV detector, Conductivity monitor,
pH, system back pressure, theoretical %B concentration, four QuadTec
wavelengths, and detector traces acquired via the System Interface Module (SIM).

Displays the Manual Setup window, which allows you to enter:

• Econo Gradient Pump (EGP) Split Time Period when the EGP is to be used.

• QuadTec UV/VIS Detector Time Constant when the QuadTec Detector is to be
used.

• Pump purge rate.

• Signal Import Module (SIM) signal parameters.
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5.3.2 System Drop-down Menus

The system drop-down menus are discussed in the following tables.

Table 5-3.
File Drop-down Menu

The File menu is always displayed. It consists of the following:

• New Method: Initiates the process of writing a new method. The new method will be saved into the
open User and Project directories. To save to a different User or Project, first select Select User and
Project. Selecting New Method during a run will automatically open the “BioLogic offline” function,
allowing you to create a method while a run is in progress.

• Copy and Edit Method: Allows you to use an existing method as a template for a new method. A copy
of the method is made, and the system software prompts you for a name change.

• New Run: Initiates a run for the currently open method. You will be prompted for a new run name prior
to launching the run.

• Open: Displays the browser. Refer to Chapter 6, Browser Screen.

• Close: Closes the current method and/or run.

• Select User and Project...: Allows you to select the default user and project of the system when new
methods are created.

• Change Name, Author...: Allows you to change the method/run name, author, and description. This
function is inactive once a run has been initiated.

• Save setup...: Allows you to save and name different hardware setups and to set one as the default.

• Load setup...: Recalls and loads the selected setup.

New Method
Copy and Edit Method
New Run
Open...
Close
Select User and Project
Change Name, Author...

Save setup ...
Load setup...

Print Report...
Data management...
Export Data...
Export Chromatogram Image...
Integration...

Exit

1 Method 1-
2 Method 2-
3 Method 3-
4 Method 4-

File ViewEdit Utilities Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>
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Table 5-3. (continued)
File Drop-down Menu

• Print Report: Allows you to print a report of the currently open method, including its setup and run data,
run results, and the run log report.

• Data Management: Displays the Browser screen, from which you can copy and move run data. Refer to
Chapter 6, Browser Screen.

• Export Data: This feature establishes data export parameters, and is available from the PostRun screen.

• Export Chromatogram Image: This feature exports a chromatogram image in a Windows Meta File
(.WMF) format. This feature is available in the PostRun screen.

• Integration: Launches the Bio-Rad EZLogic integration software. Contact Bio-Rad Technical Support at
1-800-4-BIORAD in the USA or your local Bio-Rad representative for more information on EZLogic.

• Exit: Exits the BioLogic system software and returns to the Windows desktop.

• 1 through 4: Display the last four user names and methods



Table 5-4.
Edit Drop-down Menu

Note: The Edit menu is not available in the Manual screen.

The contents of the Edit menu depends upon the currently displayed screen. In most instances, the item in
the drop-down menu also appears in the System Toolbar; exceptions are noted below.

Setup Screen

• Edit...: Allows you to edit the selected device in Setup.

• Delete: Deletes the currently highlighted device in Setup. To delete all devices, first select Select All, as
described below.

• Select All: Highlights all devices in Setup. (Not available from the System Toolbar.)

Protocol Screen

• Edit...: Displays the Edit window for the step selected in the protocol.

• Cut: Cuts (deletes) the currently highlighted step from the protocol. A cut step may be pasted
elsewhere.

• Copy: Copies the currently highlighted step so that it can be pasted elsewhere in the protocol.

• Paste: Pastes the cut or copied step into the protocol.

• Delete: Deletes the currently highlighted step from the protocol.

• Select All: Highlights all protocol steps. Cut, Copy, and Delete then act on all steps. To remove the
highlighting from individual steps, hold down the Ctrl key and click the mouse over the desired step.
(Not available from the System Toolbar.)

Run Screen

• Full view in Run Chromatogram: Zooms out to show the full view for the run.

• Multiple runs...: Specifies the number of times the method is to run.

File
Edit...
Delete

Select All

Edit View Utilities Options Window Help
Edit...
Cut
Copy
Paste
Delete

Select All:

Full view in Run Chromatogram
Multiple runs...
Start run
Pause buffer pump
Hold gradient

Edit Activity Trace ...
Tag and Trace Options ...
Full view in zoom Chromatogram
Print zoom Chromatogram
Trace Legend

Copy zoom Chromatogram to clipboard

Delete selected tag
Delete all tags

Edit menu: Setup Screen Edit menu: Protocol Screen

Edit menu: Post Run ScreenEdit menu: Run Screen

BioLogic Duo-Flow - <user name> - <project name> - <method name>

File Edit View Utilities Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>

File Edit View Utilities Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>

File Edit View Utilities Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>
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Table 5-4. (continued)
Edit Drop-down Menu

Run Screen (continued)

• Start run: Starts the run.

• Pause buffer pump: Pauses progression of method’s protocol. Stops Gradient Pumps and the method
time (volume) does not advance. From Pause, you can Abort, Continue, or Edit-During-Run.

• Hold gradient: Holds the current %B Gradient pump conditions and halts the advance of the method’s
protocol (including fraction collection). The method time (volume) does not advance. From Hold, you can
Abort, Pause, or Continue.

Post Run Screen

• Edit Activity Trace...: Allows you to input post-run sample activity data obtained off-line. (See page
7-31.)

• Tag and Trace Options...: Displays the Post-Run Tags window that allows you to specify which
traces are to be displayed, whether or not their tags are to be displayed, the tag style for the active
trace, and the values for each tag in the active trace. (Also available from the Tag button in the
System Toolbar.)

• Full View in zoom chromatogram: Allows you to view the complete chromatogram. (Also available
from the Full View button in the System Toolbar.)

• Print zoom chromatogram: Allows you to print the complete chromatogram. (Also available from
the Print button in the System Toolbar.)

• Copy zoom chromatogram to clipboard: Copies to clipboard the complete chromatogram. From
the clipboard, it can then be copied into other applications. (Not available from the System Toolbar.)

• Delete selected tag: To delete a tag, highlight the selected tag before using this function. (Also
available from the Del. Tag button in the System Toolbar.)

• Delete all tags: Deletes all tags in the chromatogram. (Not available from the System Toolbar.)

• Trace Legend: Displays different line formats for each of the chromatogram traces. This is useful for
distinguishing traces when printing to a black and white printer.
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Table 5-5.
View Drop-down Menu

The View menu selections below remain the same in each toolbar menu selection.

• Manual: Displays the Manual screen for individual control of installed instruments and devices in the
system.

• Setup: Displays the Setup screen, which allows you specify the components required for your method.

• Protocol: Displays the Protocol screen for creating and editing chromatography steps in the method.

• Run: Displays the Run screen, from which you can initiate the running of the currently open method.

• Post-Run: When a run is completed, select Post-Run to annotate the chromatogram (for example, to
apply tags to UV, Conductivity, and/or %B values).

• Run Notes: To keep notes regarding the run, select Run Notes and enter them into the Notes screen.
There are fields for description of the sample, the column, the operator, the buffer(s), flow rates,
gradients, chart speed, fraction size, and general text entry of variable length. These notes are printed
with the report.

• Run Log: Displays a log of all events occurring during the run. This information cannot be edited. The
Run Log may be disabled by selecting Edit User Preferences from the Option drop-down menu. It is
recommended, however, that the Run Log be active for assistance in troubleshooting.

Note : If the Bio-Rad EzLogic Integration software option is installed, the Log toolbar button is replaced
by the Integ toolbar button. To display the Log window, select Run Log from the View drop-down menu.

File Utilities Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>

Manual
Setup
Protocol
Run
Post-Run
Run Notes
Run Log

Edit View

INTRODUCTION TO THE SYSTEM SOFTWARESYSTEM OPERATION

5-9



Table 5-6.
Utilities Drop-down Menu

The Utilities menu selections relate to system options, and remain the same regardless of which screen is
displayed. The Utilities menu consists of the following:

• Validate Method: This verifies that the devices required by the Protocol have been defined in the Setup
screen. Validation is automatically run at the start of a new run.

• Check Hardware connections: This checks that all devices appearing in the Setup screen and
required for the run are connected to the system. Check Hardware does not detect a V7-3 Manual Inject
valve, chart recorder, Model 2110 or generic fraction collector, or Auxiliary pump, and it does not verify
plumbing connections.

• System Information: Displays the current system configuration, including each instrument in the
system and its firmware version number, the Windows® version number, available hard disk space, and
the number of methods and runs in the database.

• Diagnostics Information: Displays information for service diagnostic purposes only.

• Calibrate Gradient Pump: This selection is available only from the Manual screen, and it is typically
used only after servicing of the pump. It allows the user to calibrate the gradient pump flow rate and
zero the system pressure gauge.
Note: You must exit the Calibration screen in order for the system to accept the calibration values.

• Conductivity Flow Cell Constant Calibration: This utility allows the user to calibrate the conductivity
flow cell. The conductivity flow cell constant is printed on a tag attached to the flow cell cable. When a
new conductivity flow cell is installed, use this value to enter the flow cell constant.
Note: You must exit the Calibration screen in order for the system to accept the calibration values.

• pH Probe Calibration: This utility allows the user to calibrate the pH probe. It is typically used at the
start of each day’s use of the system.
Note: You must exit the Calibration screen in order for the system to accept the calibration values.

• EGP Calibration: This is informational only. It tells the user to calibrate the pump through the Pump
software. Refer to the EGP Instruction Manual.

File View Options Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>

Edit Utilities
Validate Method
Check Hardware connections

System Information
Diagnostics Information

Gradient Pump Calibration
Conductivity Flow Cell Constant Calibration
pH Probe Calibration
EGP Calibration
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Table 5-7.
Options Drop-down Menu

These selections are to change screen options.

• Edit User Preferences: This lets you specify the following:

Run Options: These determine whether or not the protocol’s steps are listed in the Run Log and
whether or not the valves are automatically returned to position 1 at the end of a run.

Protocol Editor Mode: This determines whether the protocol is to be based on time or volume.

• Chromatogram settings: Allows you to select which device traces will be visible on the
chromatograms. Up to 8 instrument traces are selectable from among the following: standard UV
detector, Conductivity monitor, pH, system back pressure, theoretical %B concentration, four QuadTec
wavelengths, and detector traces acquired via the System Interface Module (SIM). Both the X-axis
(time) and the Y-axis (AU) ranges can be set.

• Status Lines: Allows the status information at the bottom of the screen to be toggled on or off.

• Browser settings: This enables you to select how the browser is to display users/projects/methods/
runs. For example, select Projects to display a top level folder called “Projects” which contains all
projects in the database.

In addition, the following selection is available from the Manual screen:

• Manual Setup: This enables you to set the pump’s purge flow rate. Additionally, you can set an EGP
split time period, select a QuadTec time constant, and set the SIM-HR parameters. For the F-10 pumps,
you can specify a maximum purge rate of 10 ml/min; for the F-40 pumps, you can specify a maximum
purge rate of 40 ml/min.

File View Utilities Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method>

Edit OptionsFile View Utilities Window Help
BioLogic Duo-Flow - <user name> - <project name> - <method>

Edit User Preferences
Chromatogram Settings
Status lines
Browser Settings
Manual Setup

Edit User Preferences
Chromatogram Settings
Status lines
Browser Settings

Edit Options

Options menu: Manual Screen Options menu: Setup, Protocol, Post-Run Screen
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Table 5-8.
Window Drop-down Menu

The BioLogic Duo-Flow software allows you to continue working while a run is in progress (Offline). A
complete discussion of this function is provided in section 7.4.2, Working Offline.

• BioLogic Online: Allows you to observe and control the run in progress.

• BioLogic Offline: Allows you to write a protocol, analyze data, and export data while a separate run is
in progress.

5.4 BIOLOGIC CONFIGURATION UTILITY SOFTWARE FOR USE WHEN CHANGING PUMP HEADS

Whenever the pump heads are changed, the BioLogic Configuration Utility software must be run before the
system is used. The BioLogic Configuration software updates the flow rate and pressure ranges in the
BioLogic Duo-Flow software. To run this software:

1. Exit the BioLogic Duo-Flow software by selecting Exit from the File drop-down menu.

2. Double-click on the BioLogic Configuration icon.

3. In the BioLogic Configuration Utility window, indicate the pump that will be used with the system.

4. Exit the BioLogic Configuration Utility and double-click on the BioLogic Duo-Flow icon to start the
software.

Figure 5-2. BioLogic Configuration Utility Software Screen

File View Utilities Options Help
BioLogic Duo-Flow - <user name> - <project name> - <method name>

1  BioLogic Online - <method name>
2  BioLogic Offline - <method name>

Edit Window
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6.0 INTRODUCTION TO THE BROWSER SCREEN

The browser is the organizational tool for chromatography data. It is a database that is displayed as a tree
hierarchy which can be sorted by Users, Projects, Methods, and Runs. Figure 6-1 shows the layout of the
Browser screen.

Figure 6-1. The Browser Screen

6.1 OVERVIEW

The Browser screen displays the following information and controls:

• Collapsing/expanding the tree hierarchy:

– Click on this icon in the database tree to collapse the listing for a user, project, method,
or run folder.

+ Click on this icon in the database tree to expand the listing for a user, project, method,
or run folder.

Updates and refreshes the Browser screen by collapsing all folders to the single user
icon.
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• Icon colors in the database tree indicate the following:

Green: Currently open in the active window. The active window may be the on-line window or the
off-line window. For more detailed information about on-line and off-line, refer to the discussion in
Chapter 7, section 7.4.2, Working Off-Line.

Red: Currently open in the window that is not active. This condition is displayed during off-line use:
it applies to the method and run data for the window that is not active (on-line or off-line). Items with
a red check mark indicate that item is in the Move List or is marked for deletion.

Blue (profile): User folder

Yellow: Project folder

Blue (text page): Method folder

Blue (test tubes): Runs

• Bolded text in the database tree applies to the following:

Top level folders: Typically this applies to the USERS folder, which lists all users of the system. By
selecting Browser Settings from the Options menu, you can use the “Starting Browser Selections”
to move Projects, Methods, and Runs to the top level of the tree hierarchy where they will be bolded.

Summary information: The total number of Methods are listed for each user, and the total number of
Runs are provided for each user project folder.

Note: You cannot delete summary information.

Browser screen controls and information

• Browser toolbar: These buttons, located down the left side of the screen, control the different uses
of the Browser screen. They are discussed in greater detail on the following page.

• Name and Date bars: These are located across the top of the database tree and allow you to sort
the tree alphabetically or chronologically. These are toggle buttons. For example, if you click on the
Name button to sort from a to z, then clicking again sorts from z to a. If you click on the Date button
to sort from the latest listing, then clicking again sorts from the earliest listing.

• Browser Tabs and Browser Tab window: The Browser Tabs are at the bottom of the Browser
screen, and they control what is displayed in the Browser Tab window. The following tabs are
available:

Information tab: Clicking on this tab displays two panels in the Browser Tab window: The left panel
shows details about the specific item selected.

MOVE List tab: Displays the list of all items selected to be moved from one place to another in the
database list. Items selected to be moved are indicated by a red checkmark in the database tree.
Projects can be moved from one user to another; Methods can be moved from one Project to
another. When a Project is moved, it takes all Methods and Runs associated with it; when a Method
is moved, it takes all Runs associated with it. The procedure for moving an item is discussed later in
this chapter.

Queue tab: Displays the methods in the Queue selected or highlighted in the Browser. The
sequence of methods in a queue can be changed by dragging and dropping.

COPYIN List tab: Displays the list of all items selected to be copied in (restored) to the database
from an archived data file or disk. The procedure for copying in items is discussed on page 6-4.

Error List tab: Displays discrepancies that exist between methods in queue. These discrepancies
must be corrected to run the queue.



Browser toolbar buttons

New... The New... button creates a new User, Project, Method, Run, or Queue depending on which
icon within the Browser is highlighted.

Open... The Open... button allows you to open a selected method or run from the database tree.
Opening a Run allows you to view, analyze, and print the run data.

Note: Opening a Method or Run while a run is in progress will result in the Run-in-progress
remaining in the On-Line window and the selected method or run being opened in the Off-
Line window. For more on On-Line and Off-Line, refer to the discussion in Chapter 7,
section 7.4.2, Working Off-Line.

Edit... There are multiple functions of the Edit... button, depending upon what is highlighted when
the button is pressed.

Selecting a user or project name allows you to change that user name or project name
and/or description.

Selecting a Method or Run copies the methods to a new Setup and Protocol. The new
method will be numbered sequentially and placed in the Browser. When a method is
selected, you create a new method when you enter the method name, author, and
description. When a run is selected, you can change the run name, operator, and
description.

Note: Summary items are not editable.

Delete The Delete button eliminates Users, Projects, Methods and Runs from the Browser. This is
useful after using the Copy Out function to archive files to floppy disk, as discussed below.
To delete from the Browser, you must first delete associated data. For example, to delete a
Method, you must first delete all of the Runs associated with the Method.

Note: You cannot delete Methods or Runs from method and run summaries.

Print To generate and print the report for a run. "Print" on the browser tool bar allows multiple
runs to be printed with one command; highlight the desired group and press "Print".

CopyOut... This function lets you copy methods and runs to floppy disk or to another location on your
computer’s hard disk. The copy out function is used for backup and archiving purposes and
to transfer data to another BioLogic Duo-Flow system.

Copied out files are stored in a file with the default name biologic.zib, which is a compressed
file format to conserve disk space. The copy out function copies the User, Project, and
Method names associated with the Run.

Note: Initiating a CopyOut to floppy disk completely erases the contents of the floppy disk.
Do not use a floppy disk containing data that  you want to keep.

To copy out, highlight the Runs you wish to copy out. Press the CopyOut... button on the
Browser Toolbar. A dialog box appears which allows you to select the destination of the .ZIB
file (either the hard drive or a floppy disk). Choose the destination and press OK.
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Figure 6-2. The CopyIn Window

CopyIn... This function allows you to copy in methods and runs from a backed-up or archived .ZIB file.
To copy in, 

a. Press the CopyIn... button and select the .ZIB file you wish to CopyIn. (See Figure 6-2.)  

b. From the COPYIN List in the Browser Tab window, select the desired methods and runs.

All methods and runs in the file are displayed in the COPYIN List. (See Figure 6-3.) 

From the database tree window, click the left mouse button to select the Project to which
you want the methods and runs to be copied.

c. Again, click on the  CopyIn... button (or click on the right mouse button) and select
Copy to <project name>.

Note: Clicking the right mouse button displays all the available Browser toolbar buttons
for the highlighted selection.

d. Once you finish the copy in procedure, use the Clear List button on the Browser toolbar
to delete the remaining methods and runs in the COPYIN List.
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Figure 6-3. CopyIn with Information in Browser Tab Window

Move Move allows you to transfer a selected item from one location to another. For example, a
Project can be moved from one user to another, and a Method (and its Runs) can be moved
from one Project to another. Individual Runs cannot be moved. To move an item, 

a. In the database tree, highlight the item you want to move. You may highlight a Project or
a Method.

b. Click once on the Move button on the Browser Toolbar. The items to be moved will
appear in the MOVE List in the Browser Tab window.

c. From the MOVE List, select what you want to move.

d. From the menu tree, select the new destination for the items you are moving.

e. Again click on the Move button. The items will automatically move to the destination.
Hint: Alternatively, highlight the destination icon, right-mouse click and select the “Move
Selected” message with a left-mouse click.

f. Once you finish the move procedure, use the Clear List button on the Browser toolbar
to delete the remaining methods and runs in the MOVE List.

Queue Places methods in a queue. Highlight the method(s) you wish to place in a queue and
select Queue. The method will appear in the Tab screen. See section 6.2 for detailed
description of queuing.

Reset Updates and refreshes the Browser screen by collapsing all folders to the single user icon.
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There are several options available for how information is displayed in the Browser screen. Select Browser
Settings from the Options menu, discussed in Table 5-7 Options Drop-down Menu. The Set Browser
Options window provides the following options:

• Enable Projects: A summary of all Projects, regardless of User, will be listed in the Browser.

• Enable Methods: A summary of all Methods, regardless of User or Projects, will be listed in the
Browser.

• Enable Runs: A summary of all Runs will be listed in the Browser.

• Enable User Methods: A summary of all Methods for the specified user will be listed in the
Browser.

• Enable Project Runs: A summary of all Project Runs will be listed in the Browser.

Figure 6-4. Set Browser Options Window
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Procedures for creating a run in the Browser

1. Define a New User.

Define a new user to allow you to group your methods and runs within the Browser.

a. Click once on the Users icon in the Browser.

b. Click once on the New... button and select New User. You will be prompted for a new User Name.
Enter the name you would like to use.

c. Press OK to accept the new name.

Hint: Alternatively, highlight a User icon, right-mouse click, and select New User with a left-mouse click.

Note: If you define a new user, you must also assign a project to the user before writing a new method.

2. Define a New Project.

The Browser is further segmented into Projects within a User’s domain. To define a new project:

a. With the new User Name highlighted, click once on the New... button.

b. Select New Project. Enter the project name and description.

c. Press OK to accept the new name.

Hint: Alternatively, highlight the User icon, right-mouse click, and select New Project with a left-mouse
click.

3. Write a New Method.

To begin writing a new method from the Browser:

a. Select the Project folder or a Method in the Project folder where you want the new Method to be
located.

b. Click once on the New... button.

c. Select New Method. Enter the method name and press OK. This transfers you to the hardware
Setup screen.

Hints: 1. Alternatively, highlight the Project icon, right-mouse click, and select New Method with a
left-mouse click.

2. You can also use the New Method button in the System Toolbar. By default the system
assumes that the current user and project shown in the window title bar is the path for the
new method.

4. Name a New Run in a previously defined Method.

To start a new run from the Browser:

a. Select the Method folder or a Run in the Method folder where you want the new Run to be located.

b. Click once on the New... button.

c. Select New Run. Enter the run name and press OK. The Run screen appears. Pressing the Start
button in the toolbar will begin your sample run.

Hints: 1. Alternatively, highlight the Method icon, right-mouse click, and select New Run with a left-
mouse click.

2. You can also use the New Run button in the System Toolbar. By default the system
assumes that the current user, project, and method shown in the window title bar is the path
for the new run.
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6.2 CREATING AND RUNNING A QUEUE

Queue allows you to run multiple methods in sequence. Methods placed in a queue must have identical
hardware Setups or the system will not permit them to run.

Figure 6-5. Queues Displayed in the Browser Window

To create a queue,

1. In the Browser screen select a current user name or enter a new user name.

2. Select a current project name or enter a new project name.

3. Select the NEW icon from the left screen sidebar, and from the displayed menu select New Queue.
Enter a name and description for your queue and click OK. Your queue name will be listed under your
user and project name, and the Queue tab will appear at the bottom of the screen. (See Figure 6-5.)
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4. To place methods in a queue, highlight the method in the Browser and click the QUEUE icon on the
sidebar. Repeat until all desired methods are in the Project Queue. This places each method into your
Project Queue and the Queue Tab window at the bottom of the screen.

• Whenever you highlight the Queue icon under the Project Queue, the list of methods will appear in
the Tab window.

• Multiple methods may be selected in the Browser by either shift/click or control/click.

• Methods will run in the sequence they are listed in the Tab window. The run order of the methods
can be changed by dragging and dropping methods in the queue in the Tab window.

5. After all methods are listed in the Project Queue, click the Verify Queue button in the right sidebar of
the Tab window to confirm that all methods meet the necessary criteria to be run.

• If the methods meet the necessary run criteria to run correctly, "Methods were successfully verified"
will appear.

• If methods do not meet the necessary run criteria, a list of errors will appear. Errors will appear if
methods are not compatible to run in sequence or the hardware Setup screens are not identical.

• To run your queue, click the Run Queue icon in the right sidebar of the Tab window.

Description of the Queue Icons

Open Method: Opens a highlighted method in the Protocol screen.

Delete Method: Deletes a highlighted method from the queue. Note: This is
displayed only prior to the queue running.

Edit Method: Opens a highlighted method in the Protocol screen to be edited Note:
This is displayed only when the queue has completed its run. Queued methods
cannot be edited after the run has started.

Verify Queue: Checks methods in a queue to assure there is not a conflict in the
methods to prevent running.

If there is a conflict a list of errors will appear.

If methods are compatible the message "Methods were successfully verified,"
appears.

Run Queue: Starts a run queue.

Edit Queue: Permits editing a queue. "Edit Queue" is a "Copy and Edit" function;
i.e. it makes a duplicate.
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7.0 MODES OF OPERATION

There are two primary modes of system operation: the user can operate the system manually (from the
Manual control screen) or through the use of a user-defined Method. Each of these modes of operation is
discussed below, as well as the screens involved in setting up, defining, and running a method.

• Operating the system using the Manual control screen: This allows you to individually control the
devices and instruments connected to the Workstation. Examples of its use include purging the
pumps and equilibrating the columns. For further discussion, refer to section 7.1.

• Operating the system using a User-Defined Method: This involves the following:

Creating a new method or selecting an existing method.

Setup screen: Allows you to define the instruments and devices to be used for any method.

Protocol screen: To define each of the steps to be run during a Method. Most steps are
programmed using a dialog box to enter the parameter values. Note that the number of the step
being programmed is displayed in the upper left corner of the dialog box.

Run screen: To run a method or view a run in progress.

Start: Starts a selected run.

Note: You may move through the four screens by activating buttons on the system toolbar as long as
a run is not in progress. Those functions available during a run are discussed in section 7.4, Run
Screen.

The relationship between the the two modes of operation, as well as the screens involved in defining and
running a method, is illustrated in Figure 7-1 below.

Figure 7-1. Relationships between Modes of Operation
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7.1 MANUAL CONTROL SCREEN

The Manual Control screen allows you to control different devices and instruments on an individual basis.

Note: If an instrument is connected via the instrument bus but does not appear in the Manual screen, check
that its power switch is On and that the instrument bus cable connection is secure.

Figure 7-2. Manual Control Screen, showing a Model 2128 Fraction Collector, QuadTec Detector,
Econo Gradient Pump, and Four Valves

From the Manual control screen you can control the following:

• Gradient Pump: This control panel allows you to control the composition of the mobile phase being
pumped, set the flow rate and pressure limits, and start/stop the pump. (User-defined pressure limit
settings is discussed in the section below.)  If the pressure limit is exceeded, the pumps stop.

Note: Changing pressure limits requires pressing either the Start or Set buttons. When the pump is
running, changing any parameters requires pressing the Set button.
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The fraction collector, detectors, and Econo Gradient Pump have two modes of operation: System,
in which the full functionality of the unit is available from the BioLogic Duo-Flow system software,
and Local, in which control of the device is from its front panel faceplate.

• Fraction Collector: When a Bio-Rad Model 2128 Fraction Collector is connected, the control panel
displays the “Tube number,” which is the tube currently under the drop-head (assuming the run
started at tube 1), and the “Volume left,” which is the volume remaining to be delivered. There are
also toggle buttons for Start and Stop and a button for Advance. Note that the Tube number is a
display field only.

Note: Fraction collection is always by Volume. Collection by Drop or Time is not supported by the
BioLogic Duo-Flow software.

• Econo Gradient Pump: For this optional peristaltic pump the control panel allows you to select a
flow rate, determine percentage of flow divided by the EGP splitter valve, select a flow direction and
start and stop the pump. Specific details for operation will be in the EGP user instruction manual.

• QuadTec Detector: For this optional UV/Vis detector the control panel allows you to select 4
wavelengths and to zero them. The QuadTec down arrow in the upper right corner of the control
panel toggles between the QuadTec and the standard UV detector. Specific details for operation of
the QuadTec detector can be found in its instruction manual.

• Standard UV Detector: The control panel provides access to the standard UV detector, Chart
Recorder and indicates Signal Import Module Status. It allows you to turn the UV Lamp on and off
and to zero the baseline.

• Chart Recorder: If you are using the standard UV detector and Conductivity monitor, you can set
the chart recorder full scale ranges, start/stop the recorder, and send an event mark. The full scale
ranges set here apply to the chart recorder and are not reflected in chromatograms displayed on the
computer screen.

• Signal Import Module (SIM 1 and 2): This panel indicates the presence of up to two Signal Import
Modules (SIM-HR). The signal from an analog instrument connected to the SIM is digitized so that
the instrument can be monitored from the BioLogic Duo-Flow system. Instruments that may be
connected include any detection source, such as a variable wavelength UV detector, a pH meter, a
refractive index detector, or a fluorescence detector. For more information, refer to Chapter 2.4.1
and to the separate instruction sheet for the SIM-HR module.

• Valves: Allows you to control the valve position of any of the BioLogic Duo-Flow solenoid or
automated valves connected to the system.

In addition, the Manual control screen chromatogram displays the system output for up to 8 instrument
traces from any of the following: standard UV detector, conductivity, pH, pressure, theoretical %B
concentration, four QuadTec wavelengths, and detector traces acquired via the System Interface Module
(SIM). Use the scroll bars, the Settings button in the toolbar, or the Chromatogram Settings selection
under the Options drop-down menu to change the x- and y-axes settings. The drop-down menus on either
side of the chromatogram permit selection of a trace for adjustment to its sensitivity reading.

7.1.1 Pressure Limit Settings

The Duo-Flow system is designed for pressures to 3500 psi, with the standard F-10 pump heads installed.
The optional F-40 pump heads are rated to 1000 psi at 40 ml/min. If you will be using a column designed for
lower pressures, you can set a lower pressure limit for the system. From the Gradient Pump panel, set the
high limit to the appropriate value for the column. Set a low limit that is 6 psi or greater (the system does not
allow minimum pressure below 6 psi) to protect the system from pumping air if it runs out of buffers or
mobile phase. If the pressure limits are exceeded, the pumps stop.

Note: Changing pressure limits requires pressing either the Start or Set buttons.
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7.2 SETUP SCREEN

The Setup screen is used to select instruments/devices to be used in the Protocol for a particular user
defined method. Each Method has its own instruments/devices Setup. For example, if you plan to use a
Model 2128 Fraction Collector for different methods then you must select this particular collector in each
Setup screen for each method.

If you routinely use the same Setup(s), it is recommended to select Save setup... from the File drop-down
menu. This allows you to save and name different hardware setups and to set one as the default. The
default or selected setup is then loaded each time you create a New Method, thus eliminating the need to
build a new Setup each time.

In figure 7-3, Setup screen devices are chosen from the left hand “Available Devices” box. A dialog box will
appear allowing you to label the device in the Method. For example, an AVR7-3 may be selected and then
defined as a Sample Inject Valve. Use the Delete button in the System Toolbar to remove a device from the
Devices in Setup window. In order to run your Method, these devices must be connected to the rear of the
Workstation and they must be powered on.

Note: Devices may not be properly connected to the system but may be included in the Setup. The run will
not start, however, until the devices are connected. An error message will appear on the Run screen.

Figure 7-3. Setup Screen
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Valve Functioning and Naming

One of the most powerful features of the BioLogic Duo-Flow Software is the ability to define the specific
purpose of the automated valves and to name each valve position. This greatly simplifies programming
individual steps in the Protocol screen.

For example;

• The most common use of an AVR7-3 valve is as a Sample Inject Valve. Once an AVR7-3 valve has
been assigned to this function, the software controls all of its valve changes based on the
programmed sample injection step.

• The most common use of a SVT3-2 valve will be as a Fraction Collector Diverter valve with a Model
2110 or generic collector. Once an SVT3-2 valve has been assigned to this function, the software
controls eluant diversion based on the programmed fraction collection scheme.

In summary, you can identify the following as applying to all valves:

• Valve Name/Function. What is the valve to be used for? Select from the drop-down list box or input
a unique function that you will recognize when the particular valve is selected in the Protocol screen.

• Connector. Which connector at the rear of the workstation is the valve connected to? 

• Position Names. These fields let you name each valve position.

The following devices are listed in the Setup screen. Because the standard UV detector, Conductivity
monitor, and AVR7-3 valve are standard with the BioLogic Duo-Flow system, they are always listed in the
Devices in Setup panel. To eliminate any of these, highlight it and click the Delete button.

• Auxiliary Load Pump: Allows you to use an Auxiliary Load Pump, such as the Model EP-1 Econo
Pump or the Econo Gradient Pump (EGP). See Section 4, Advanced System Applications, for ways
to incorporate an auxiliary load pump into a method.

• Fraction Collector: Select this button if you are using a fraction collector with the system. A dialog
box appears, allowing you to select a Model 2110, Model 2128, or generic (non-Bio-Rad) fraction
collector. If you use threshold detection to initiate fraction collection, select the appropriate detector.

Select a delay volume or leave at default of zero. The Delay function precisely synchronizes fraction
collection with the UV signal on the chart recorder. It is defined as the tubing volume between the
UV detector and the fraction collector drop-head. If you are using the recommended 1/16” (1.6 mm)
OD, 0.020” (0.51 mm) ID Tefzel tubing, 1 cm of tubing has a volume of 2 µl. The volume of the
supplied backpressure regulator is 146 µl.

Note: To enable the use of collection windows or threshold collection for a Model 2110 or generic
fraction collector, it is necessary to assign an SVT3-2 valve as the fraction collector diverter valve.

• Detectors: The QuadTec multiwavelength detector is available as an option from Bio-Rad; it is
discussed in greater detail in its instruction manual. The standard UV detector and Conductivity
monitor are standard with the Duo-Flow system. The SIM/pH is for use with Bio-Rad’s optional pH
monitor and SIM (Signal Import Module). SIM Signal is for use with non-Bio-Rad detectors, such as
refractive index and fluorescence detectors.

The SIM Signal button requires that you set the Units and the minimum and maximum for the Units
Range and Device Output Range (volts). Select the device number on the SIM-HR to match the
number displayed. Refer to the analog device’s documentation for information on output voltages.

• Valves (SVT3-2, SV5-4, AVR7-3, and AVR9-8): The BioLogic Duo-Flow system’s automatic valves
can be configured in a number of different ways depending on their function in a method. Table 7-1
discusses how each of the valves can be set up.

• Gradient Pump: Inlets A and B may be renamed by overwriting “Buffer A” and “Buffer B” with the
description of the buffer.
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Table 7-1.
Valve Setup Information
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Notes

Functions as a fraction collection diverter,
determined by the actual fraction collection
parameters chosen.

When used before the inlet to Pump A or B, the
valve enables buffer selection. The buffer name
specified for each position will appear in the
Protocol screen’s “Isocratic Flow”, “Linear
Gradient”, and “Change Valve” dialog box. Refer
to Chapter 8, Sample Loading, for examples.

Used for auxiliary pump load selection to select
one of two solutions. Refer to Chapter 8, Sample
Loading, for examples.

When used for a purpose other than described
above. The name specified for each position will
appear in the Protocol screen’s “Change Valve”
dialog box.

When used before the inlet to Pump A or B, the
valve provides preparative sample loading or
buffer selection. The buffer or sample name
specified for each position will appear in the
Protocol screen’s “Isocratic Flow”, “Linear
Gradient”, and “Change Valve” dialog box. Refer
to Chapter 8, Sample Loading, for examples.

Used for Auxiliary Pump load selection to select
one of four solutions. Refer to Chapter 8, Sample
Loading, for examples.

When used for a purpose other than that
described above. The name specified for each
position will appear in the Protocol screen’s
“Change Valve” dialog box.

For automatically loading a sample.

Valve Type Valve Name/ Position 
Function Names

SVT3-2 Fraction Collector 1 Waste
Low pressure Diverter 2 Collect
solenoid valve

Inlet A Named by user

Inlet B Named by user

Aux Pump Inlet Named by user

User-assigned Named by user
name

SV5-4 Inlet A Named by user
Low pressure
solenoid valve Inlet B Named by user

Aux Pump Inlet Named by user

User-assigned Named by user
name

AVR7-3 Sample Inject 1 Load Sample
High pressure 2 Inject Sample
valve 3 Purge



Table 7-1. (continued)
Valve Setup Information
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Valve Type Valve Name/ Position 
Function Names

AVR7-3 User-assigned Named by user
(cont’d) name

AVR9-8 Aux Pump Inlet Named by user
High pressure
valve

Inlet A Named by user

Inlet B Named by user

Fraction Collector 1 Waste
2 Collect
3-8 Named by 

user

User-assigned Named by user
name

Column Switching Named by user

Notes

When used for a purpose other than described
above. The name specified for each position will
appear in the Protocol screen’s “Change Valve”
dialog box. Refer to Section 4, Advanced System
Applications, Chapters 8 through 10.

Used for Auxiliary Pump load selection to select
from up to eight samples, buffers, or rinse
solution.

When used before the inlet to Pump A or B, the
valve provides preparative sample loading or
buffer selection. The buffer or sample name
specified for each position will appear in the
Protocol screen’s “Isocratic Flow”, “Linear
Gradient”, and “Change Valve” dialog box. Refer
to Section 4, Advanced System Applications,
Chapters 8 and 9.

Useful for collecting large volume samples.
Collects up to 8 samples. The name specified for
each position will appear in the Protocol screen’s
“Change Valve” dialog box.

When used for purposes other than described
above. The name specified for each position will
appear in the Protocol screen’s “Change Valve”
dialog box. Refer to Chapters 8 and 9.

Allows you to install up to 8 columns and assign
valve numbers and names to each column.
Requires two AVR9-8 valves: one is an inlet valve
and the other functions as an outlet valve.



7.3 PROTOCOL SCREEN

The Protocol screen allows you to program step-by-step instructions for running a method.

Note: Methods may be programmed either by Volume (ml) or Time (min). The default (time or volume) is set
by selecting Edit User Preferences from the Options drop-down menu.

The Protocol screen contains the following types of icon buttons, which are shown in Figure 7-4 and
described in detail in this section.

• Add Step buttons: These buttons are used to define the steps in the protocol. They are located in a
vertical box on the left side of the screen. To insert a step, highlight the step below where the new
step is to be added, and then press the appropriate button to begin defining that step. For example,
selecting Isocratic Flow displays a dialog box allowing you to define the buffer and volume (or time)
and flow rate.

• Fraction Collector button: This button is used to define the fraction collection scheme. It is located
below the Add Step buttons.

• Edit buttons: These buttons, located in the System Toolbar, are used to edit, cut, copy, paste, and
delete steps from the method. To cut, copy, or delete a step, select that step and then press the
appropriate button. To paste, select the step below where the step is to be pasted and then paste.

• File Buttons: Use the New Method, Edit Method, and Browser System Toolbar buttons to create a
new method or to open an existing Method.

The system checks the Setup information before allowing you to add steps or run the Method. This ensures
that each device you need is present and available for the required function.

Figure 7-4. Protocol Screen
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The following tables describe each button in the “Add Step” column of the Protocol screen.

Table 7-2.
Isocratic Flow 

To deliver a buffer under isocratic conditions. The composition may be chosen by altering
either Inlet A or Inlet B percent values which increase or decrease in tandem. Use the
up/down arrows or input values from the keyboard when this field is highlighted.

• Buffers: Displays all available buffers for separation. Buffer A and Buffer B can be labeled to identify
the buffer in use by editing the Gradient Pump fields in the Setup screen. If pump inlet valves are
assigned in the Setup screen and buffers are defined, all additional buffers will be displayed in the drop-
down boxes.

• Composition: Allows you to choose the buffer composition (e.g., 75% A  and 25% B).

• Volume/Time: Allows you to choose the duration of the step.

• Flow rate (ml/min): Allows you to choose the flow rate of the step.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Cancels all input. This is the same as pressing the Esc key on the keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Isocratic Flow

Step 2, Volume = 0.00 ml

Isocratic Flow

A-Buffer 1

OK Cancel

100A

Buffer B

Buffers % Composition

0

1.0

Volume (ml.)

1.00B

Flow (ml./min)
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Table 7-3.
Load/Inject Sample 

To program the sample injection. The Load Sample dialog box allows you to specify the
device that will load sample onto the column, as well as the volume of sample to be loaded.
(If programming in time mode, the system calculates the time required for this step.)

• Load/Inject Sample: Explains the action of the valve. The AVR7-3 auto inject valve will move to the
Inject position at the start of the step and return to the Load position at the end of the step.

• Type: There are three options for sample loading. Refer to Section 4, Advanced System Applications,
for examples.

Static Loop: This is a standard fixed volume loop for sample loading. On the AVR7-3 valve, the loop is
connected at ports 3 and 6, and sample can be loaded with a syringe through port 2. By adding an
Auxiliary (AUX) pump and an auxiliary pump valve (such as the SVT3-2, SV5-4, or AVR9-8), the system
can fill the sample into the static loop prior to injecting it onto the column, and it can rinse the sample
loop after the sample has been injected. Fill Before Inject and Rinse After Inject are active when an Aux
pump is used to load sample. Volumes for pre- and post-rinse can be selected in these two tab windows.

Dynamic Loop: This uses Bio-Rad’s DynaLoop or other sliding-piston sample loop. Both partial loop
and full loop injections can be programmed. By adding an Auxiliary (AUX) pump and an auxiliary pump
valve (such as the SVT3-2, SV5-4, or AVR9-8), the dynamic loop can be filled prior to injection onto the
column. The Rinse function is not available. The dynamic loop can also be filled manually through Inject
valve port #2.

Direct Inject: Allows direct injection of sample through either the Workstation pump or auxiliary load
pump. Pre-pump valves (such as the SVT3-2, SV5-4, or AVR9-8) automate direct injection. Use of an
auxiliary pump (such as the Bio-Rad Model EP-1 Econo Pump or EGP peristaltic pump) allows direct
injection of sample onto a low pressure column (<15psi). Use of an Auxiliary (AUX) pump and an
auxiliary pump valve allows multiple direct injections onto a low pressure column.

• Injection Buffers and % Composition: These fields allow you to choose the buffer and composition
which will push the sample through the sample loop.

• Volume: Allows you to specify the volume of the sample to be injected. The smallest volume selectable
is 0.1 ml; the largest volume selectable is 9999 ml (for larger volumes, use another Load/Inject Sample
step). Actual load volume is defined by the sample loop size.

• Flow Rate: Allows you to specify the flow rate for the sample injection step.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Does not add the step to the protocol. This is the same as pressing the Esc key on the
keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Load/Inject Sample

Step 3, Volume = 1.00 ml

Load/Inject Sample Fill Before Inject

A-Buffer 1

OK Cancel

Rinse After Inject

100A

Buffer B

Injection Buffers
Type

% Comp.

0

1.0

Volume (ml.)

1.00B

Flow (ml./min)

Static Loop

Dynamic Loop

Direct Inject

Alarm will sound and Protocol will HOLD for Start of Injection, then CONTINUE at end of this step.
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Table 7-4.
Linear Gradient 

To deliver buffer gradients. The Linear Gradient dialog box sets the initial and final
composition of the buffers and the period over which the change in composition is to occur.
There is no limit to the number of gradient steps in a protocol.

• Buffers: Allows you to choose two buffers to make a binary gradient. Drop-down menus display all
buffers that are set up using BioLogic Workstation pump Inlet valves.

• % Composition: Allows you to choose initial and final values that will form a linear binary gradient.
Notice that changing one value in the “Initial” column affects the other “initial” value. The “Final” column
behaves identically.

• Volume: Allows you to choose the duration of this step.

• Flow: Allows you to choose the flow rate of this step.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Does not add the step to the protocol. This is the same as pressing the Esc key on the
keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Linear Gradient

Step 8, Volume = 2.00 ml

Linear Gradient

A-Buffer 1

OK Cancel

100A

B-Buffer 1

Buffers % Composition

Initial

0

100

Final

0

1.0

Volume (ml.)

1.00B

Flow (ml./min)

MODES OF OPERATIONSYSTEM OPERATION

7-11

Linear
Gradient



Table 7-5.
Change Valve 

To select any valve and change its position.

• Change Valve name and position: These fields allow you to choose a valve and to make a change in
valve position. Note that certain valve functions defined in the Setup screen (such as Fraction Collector
Diverter, Aux Pump Inlet, Sample Inject, Inlet A, Inlet B)  are “tied” to other Protocol steps, so valve
position changes will be made automatically. An example would be an AVR7-3 valve defined as a
Sample Inject valve in the Setup screen, which is then tied to the Load/Inject Sample step in the
Protocol screen.

Valves assigned a “User-defined name” during Setup require the “Change Valve” step at the desired
point in the Protocol.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Does not add the step to the protocol. This is the same as pressing the Esc key on the
keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Change Valve

Step 8, Volume = 2.00 ml

Change Valve

SVT3-2 Valve - Inlet A Port 1
SVT3-2 Valve - Inlet B Port 2
AVR7-3 Valve - User Assigned Name Port 4

OK Cancel

A-Buffer 1
A-Buffer 2

SVT3-2 Valve - Inlet A Port 1

Valve Position
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Table 7-6.
Column Switching 

The BioLogic Duo-Flow system supports the use of more than one column during a run.
(Chapter 9 provides two examples of column switching during a run.)  Use this button to specify
which column to load sample onto.

Column switching is supported by installing two AVR9-8 valves that permit the use of 8 different analytical
and separation columns. The AVR9-8 valves are defined by selecting Column Switching in the Setup
screen. This identifies the two valves as installed and synchronizes the switching of the valves without
further user input. Column switching permits identification of the electrical connection port of each valve and
user naming for each column. Installation of the AVR9-8 valve in Setup automatically activates Column
Switching in the Protocol screen.

• Position: Select the column to switch to in a run.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Does not add the step to the protocol. This is the same as pressing the Esc key on the
keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Switch Columns

Step 8, Volume = 5.00 ml

Switch Columns

OK Cancel

Column 1
Column 2
Column 3
Column 4
Column 5
Column 6
Column 7

Position

MODES OF OPERATIONSYSTEM OPERATION

7-13

Column
Switching



Table 7-7.
Hold Until

Inserts a Hold step into the method. The Hold step stops the progression of the method; the
pumps continue pumping at the Hold step %B composition. The method time (or volume)
advances. When the run resumes, the current fraction collection condition is maintained. The

hold condition is maintained until a specified activity occurs (e.g., “Hold until Start of Inject” or “Hold until
Keypress”). For example, if the hold starts at time 2 (minutes), then the method resumes at time 2, no
matter how long the Hold was in effect.

Hold Until and Threshold Detector: Choose one of five events to discontinue the hold:

• Key Pressed: Press the F2 key on the keyboard to end the programmed hold.

• Start of Inject: The run will continue when the manually-controlled device (which must be connected to
the Workstation AUX connector at pin 1, Inject) is moved to its desired position.

• End of Inject: The run will continue when the manually-controlled device (which must be connected to
the Workstation AUX connector at pin 1, Inject) is returned to its original position.

• Above Threshold: The run will continue when threshold exceeds that specified by the following fields in
this window:

Threshold Detector: Select the desired threshold detector absorbance, conductivity, RI, etc.

Threshold: Specify a threshold value.

• Below Threshold: The run will continue when threshold falls below that specified by the following fields
in this window:

Threshold Detector: Select the desired threshold detector absorbance, conductivity, RI, etc.

Threshold: Specify a threshold value.

• Time Out Reqd and Time Out (min): To hold for a specified length of time.

• Sound Alarm: When this box is checked, an alarm will sound at the beginning of the step to remind you
that the system requires an action on your part to allow the method to advance.

• OK: Adds the step to the protocol. This is the same as pressing the Enter key on the keyboard.

• Cancel: Does not add the step to the protocol. This is the same as pressing the Esc key on the
keyboard.

• Step, Time or Volume: Identifies current step number, and calculates the elapsed time or volume from
all previous steps. This is not user editable.

Edit Hold Event

Step 1, Volume = 0.00 ml

Hold Until Event

OK Cancel

UV Detector

1.000

Time Out (min)

The method will automatically
continue after the selected
time-out duration

Threshold

Key Pressed Time Out Reqd.

Sound Alarm

Start of Inject

End of Inject

Above Threshold

Below Threshold

Hold Until Threshold Detector

MODES OF OPERATION SYSTEM OPERATION

7-14

Hold



Table 7-8.
Miscellaneous 

Button Description

To repeat the highlighted step(s) a specified number of times. To highlight more than one
step, hold down the Ctrl key while selecting steps with the mouse.

To pause the method at a specific step during the run. Pause stops the progression of the
method and time, holds the %B composition, and stops the pumps. Time Out Req’d permits
a pause time to be entered. The step will be paused for the specified length of time, after
which it will automatically resume. An audible alarm may be programmed to sound when the
step is paused and when it automatically resumes.

To sound a 10 second audible alarm at the programmed time. The progress of the run will
not be affected.

To zero the UV baseline at the programmed time.

At system start-up, the default condition is Lamp ON. If the lamp is OFF, it takes about 20
minutes for the lamp to warm up prior to use.

To turn the Chart Recorder on/off at the programmed time. Inserts a step that tells the Chart
Recorder to start/stop the paper feed and lower/lift the pen.
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Table 7-9.
Fraction Collection 

Button Description: Collect All

To set up fraction collection. Fraction collection schemes are discussed below.

IMPORTANT NOTE:

The BioLogic Duo-Flow system is designed to control the Model 2128 Fraction Collector, which is the only
collector that provides a choice of racks and the ability to overlay fractions from consecutive runs.

The BioLogic Duo-Flow system will also accommodate the Bio-Rad Model 2110 Fraction Collector as well as
generic collectors. To use a fraction collection scheme other than “Collect All” with these collectors, it is
essential to assign a SVT3-2 valve as a “Fraction Collector Diverter” in the Setup screen. Rack choice and
Overlay features are not available with these collectors.

Collect All: The eluant from the entire run will be collected by the fraction collector.

• Fraction Size: Enter the fraction size as volume (ml).

• Rack: This applies only to the Model 2128 Fraction Collector. The following racks may be specified:
1 128 tubes; 12-13 mm tube diameter
2 78 tubes; 16-18 mm tube diameter
3 Microplates, 3 plates total for 288 wells (96 wells/plate, arranged 8x12)
4 Microtubes (128 capless microtubes)
5 Prep-Bottle (10 bottles of any size)
6 Microplate: 72 wells (24 wells/plate x 3 plates)

• Tubes Required: The displayed value is calculated based on the total volume divided by fraction size.

Collect All

Threshold

Collection Windows

Threshold and Collection Windows

Volume Description

Volume Description

Fraction Collection Scheme Rack

Close

Fraction Collection Scheme

1.00

Close

Waste

Destination:

Non-peak Parameters:

Tubes

Fraction Size

ml

1

Number of racks

Tubes Required 5
1

Start Tube

128

End Tube

1.00

Fraction Size

ml

0.100

Threshold

AU

Rack

Rack

1 (12-13mm tubes)
2 (16-18 mm tubes
3 (Microplate(96 well plate))
4 (Microtubes)
5 (Prep Bottle)
6 Microplate(24 well plate))
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Table 7-9. (continued)
Fraction Collection 

Description: Collect All (continued)

• Number of Racks: Indicate the number of racks to be used for fraction collection. The Model 2128
Fraction Collector permits more than one rack to be used. The system will pause and a yellow prompt
will tell you to change the rack and continue the method.

• Start Tube and End Tube: This applies only to the Model 2128 Fraction Collector. Identify the first and
last tubes to receive fractions.

Description: Threshold

Threshold: This method allows the flow to be sent to the collector if the detector signal of the eluant is
above a certain signal level. Note: You can select any detection source to initiate threshold-based fraction
collection. Non-peak eluant can be sent to waste or to the fraction collector.

• Fraction Size, Rack, Tubes Required, Number of Racks, Start Tube, and End Tube: See description
for Collect All on page 7-16.

• Threshold: Enter the threshold value in absorbance units. Fractions will be collected whenever the
detector output goes above the threshold level.

• Non-peak parameters Destination and Fraction Size: Enter the non-peak parameters. If the buffer
stream is diverted to Waste, there is no need to enter a fraction size. But if you want to collect non-peak
material, you must enter a fraction size.

Collect All

Threshold

Collection Windows

Threshold and Collection Windows

Volume Description

Volume Description

Fraction Collection Scheme Rack

Close

Fraction Collection Scheme

1.00

Close

Waste

Destination:

Non-peak Parameters:

Tubes

Fraction Size

ml

1

Number of racks

Tubes Required 5
1

Start Tube

128

End Tube

1.00

Fraction Size

ml

0.100

Threshold

AU

Rack

Rack

1 (12-13mm tubes)
2 (16-18 mm tubes
3 (Microplate(96 well plate))
4 (Microtubes)
5 (Prep Bottle)
6 Microplate(24 well plate))
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Table 7-9. (continued)
Fraction Collection 

Description: Collection Windows

Collection Windows: This method specifies collection during specified parts of the run (Time or Volume).
Each collection window can have a unique fraction size (ml).

Note: Collection windows programming should be done after all other steps have been written. When using
Collection Windows, the Model 2128 will skip a tube between each window collection. For example, if the
first window ends collection at 20 minutes and the second window starts collection starting at 21 minutes,
then the fraction collector will leave an empty tube for the period between minutes 20 and 21.

• Fraction Size, Rack, Tubes Required, Number of Racks, Start Tube, and End Tube: See description
for Collect All on page 7-16.

• Add Mode: Enter the desired values for Start, End, and Frac Size.
a. Select the Save Window button and the values will appear in line 1.
b. Enter the values for the next window and select Save Window. The values will appear in line 2.
c. When the collection scheme is complete, select Finished Adding, and the Select Mode will appear.

• Select Mode: This mode (not shown in illustration above) shows the following two buttons:
Add Window: Inserts a window after the highlighted window.
Delete Window: Deletes that window.

Collect All

Threshold

Collection Windows

Threshold and Collection Windows

Volume Description

Volume

1

2 7.0

Start
(ml)

Description

Fraction Collector Scheme Rack

Close

CollectionWindows

CollectionWindowsFraction Collector Scheme

2.07

Close

Close

Save Window

ADD MODE

Delete Window

Finished Adding

Waste

Destination:

Non-peak Parameters:

Tubes

Fraction Size

ml

1

0.0

Number of racks

Tubes Required 5
1

Start Tube

288

End Tube

1.00

Fraction Size

ml

0.100

Threshold

AU

Rack

Rack

CollectionWindowsFraction Collector Scheme Rack

1 (12-13mm tubes)
2 (16-18 mm tubes
3 (Microplate(96 well plate)
4 (Microtubes)
5 (Prep Bottle)
6 Microplate(24 well plate)

6.0

End
(ml)

4.0

1.00

4.0 5.0 0.60

Frac. Size
(ml)

0.60
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Table 7-9. (continued)
Fraction Collection 

Description: Threshold and Collection Windows

Threshold and Collection Windows: Each Collection Window (discussed on page 7-18) can also contain a
threshold value to further discriminate when eluant can be collected. For each collection window, non-peak
effluent can be directed to waste or to the fraction collector. The Threshold and Time windows can be
combined, so the system collects fractions only during the programmed Time windows and within the Time
windows only when UV absorbance is above the threshold value.

Collect All

Threshold

Collection Windows

Threshold and Collection Windows

Volume Description

Volume

Start
(ml)

Description

Fraction Collector Scheme Rack

Close

CollectionWindows

CollectionWindowsFraction Collector Scheme

2.07

Close

Close

Save Window

ADD MODE

Delete Window

Finished Adding

Waste

Destination:

Non-peak Parameters:

Tubes

Waste

Tubes

Fraction Size

ml

1

0.0

Number of racks

1

Start Tube

288

End Tube

1.00

Fraction Size

ml

0.100

Threshold

AU

Rack

Rack

1 (12-13mm tubes)
2 (16-18 mm tubes
3 (Microplate(96 well plate)
4 (Microtubes)
5 (Prep Bottle)
6 Microplate(24 well plate)

End
(ml)

5.0

Frac. Size
(ml)

1.00

Thresh
(AU)

1.00

Thresh.
(AU)

Non-Peak Frac. Size
(ml)

Non-Peak Frac. Size
(ml)

0.01

Start
(ml)

Close

Add Window

SELECT MODE

Delete Window

CollectionWindowsFraction Collector Scheme Rack

CollectionWindowsFraction Collector Scheme Rack

End
(ml)

Frac. Size
(ml)

1

2 7.0 6.0 1.00 0.010 Waste

4.0 5.0 0.60 0.000 Waste

1

2 7.0 6.0 1.00 0.010 Waste

4.0 5.0 0.60 0.000 Waste
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Table 7-9. (continued)
Fraction Collection 

Description: Threshold and Collection Windows (continued)

When using the Collection Windows functions, the Model 2128 will skip a tube between each window
collection. For example, if the first window ends collection at 20 minutes and the second window starts
collection starting at 21 minutes, then the fraction collector will leave an empty tube for the period between
minutes 20 and 21.

• Fraction Size, Rack, Tubes Required, Number of Racks, Start Tube, and End Tube: See description
for Collect All.

• Start (ml), End (ml), Fraction Size (ml), Thresh (AU), and Non-Peak Frac Size (ml): Each window is
defined by these parameters. Use the scroll bar to the right of the window display to scroll through the
list of windows. Enter the fraction size as volume (ml).

• Add Mode: Enter the desired values for Start, End, Frac Size, and Thresh.

Select the Save Window button and the values will appear in line 1.

To enter the values for the next window, select Add Window and enter the values. Select Save Window
and the values will appear in line 2.

When the collection scheme is complete, select Finished Adding, and the Select Mode will appear.

• Select Mode: This mode shows the following two buttons:

Add Window: Inserts a window after the highlighted window.

Delete Window: Deletes that window.

• Non-peak parameters Destination and Fraction Size: Enter the non-peak parameters. When
collecting non-peak material, you must enter a fraction size.
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The following Toolbar menu options are available only when creating and editing a protocol.

Table 7-10.
Protocol Screen’s Editing Toolbar 

Button Description

Edit buttons: These buttons are available from the System menu.

To edit the currently highlighted step(s) in the protocol. If multiple steps are
highlighted any changes will be reflected in all steps.

To cut the currently highlighted step from the protocol. It places the step in the
clipboard, which means it can be placed elsewhere by using the Paste button.

To copy the currently highlighted step in the protocol.

To paste the cut or copied step before the currently highlighted step.

To delete the currently highlighted step from the protocol.
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7.4 RUN SCREEN

The Run screen displays a run in progress. All data associated with the run are automatically saved. An
example of a run in progress is shown in Figure 7-5 below. Table 7-11 discusses the buttons which may be
used to control the run. Note: If the Bio-Rad EzLogic Integration software is installed, the Integ. toolbar
button appears.

Figure 7-5. Run Screen showing a Run in Progress
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Table 7-11.
Run Screen’s Control 

Button Description

Advances the fraction collector to the next tube. Pressing this button does not
modify the method. The event is recorded in the Run Log.

Immediately changes the position of the diverter valve. Pressing this button does
not modify the method. The event is recorded in the Run Log.

To set the pressure limits of the Workstation pump. This is not part of a protocol; it
is a system setting from the Manual screen. The pumps will stop when the pressure
goes above or below the set values.

To set the UV Detector range for the Chart Recorder output. The settings are:
0.001, 0.002, 0.005, 0.01, 0.02, 0.05, 0.1, 0.2, 0.5, 1.0, 2.0 AUFS.

To set the Conductivity range on the Chart Recorder output. The settings are:
500, 200, 100, 50, 20, 10, 5 mS/cm.

To set an Event Mark on the chart recorder UV trace output only. It will not record
event marks on the screen.

Use the Zero Baseline button to reset the UV or QuadTec detector absorbance
value to zero.
Note: Use care during a collection scheme which uses a Threshold value.

These drop-down menus, located on either side of the chromatogram, are used to
select the active data trace to be scaled during or after a run. As each trace scale
is selected, the scroll bars can be used to adjust the scale setting.

To work offline while a run is in progress. (Refer to section 7.4.2, Working Offline.)

Notes displays the Run Notebook screen, which allows you to enter notes regarding
the run.
Log displays the Run Log screen, which provides information about the run and is
non-editable.

To stop, pause, or hold a method in progress. (Refer to Figure 7-6.)

To select which traces to display in the chromatograms. (Refer to Table 5-2.)

MODES OF OPERATIONSYSTEM OPERATION

7-23

Advance

Frac. Collector

Divert Valve

Collect

Waste

Set

Grad. Pump

400

High psi

20
Low psi

UV Range

Event
mark

Cond Range

500

Chart Recorder

0.2

Zero
Baseline

Conductivity

UV

BrowserMethod
New

PauseAbort Hold

LogNotes

Settings



7.4.1 Pausing/Stopping a Method in Progress

The Run screen provides three options for pausing or stopping a method in progress, as discussed in the
figure below.

Figure 7-6. Run Screen’s Abort, Pause, and Hold Buttons
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Continue, Abort, or  Edit Protocol.

Stops the current run and saves
the data. (A confirmation message
is presented to prevent accidents.) 
The run cannot be continued.

To continue the method run. Protocol screen (View only) lets you
view the steps in the run. Select Run 
or Edit Protocol. From Run, select 
Abort or Continue. Edit Protocol involves
the buttons shown below.

Abort
Stops progression of method and 
method time.  Pumps continue pumping 
at Hold %B concentration, and valves 
remain in Hold position.  From Hold you 
can Continue, Abort, or Pause. You 
cannot edit.

Hold
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Setup screen lets you view the list of
devices available to the method.  From
Setup, you can select Protocol or Run. 
From Run, select Abort or Continue. 

Pressing this button initiates the
process of editing the method's protocol. 

After editing the method's protocol,
return to the Run screen.  You then
can Continue or Abort the run.

Edit
Protocol

wash
load

1
2

hold
alarm

3
4

If there's a run already associated
with the method, the method is
copied and you must rename it. 

Method Name:
Method Description:
Method Author: You may edit the method's protocol

using any of the Add Step buttons
and the Cut, Copy, Paste, and
Delete buttons. 



7.4.2 Working Offline During a Run

The BioLogic Duo-Flow system software allows you to work offline, creating a new method or editing an
existing method, while a run is in progress. The following actions can be performed:

• Write a new method

• Edit an existing method

• View results from a completed run

• Print a report from a completed run

• Integrate run data from a completed run (using the optional EZLogic software)

• Perform PostRun analysis on a completed run

• Export Data or Export Chromatogram Image of a completed run

• Access the HELP screen

These functions are not available while a run is in progress:

• PostRun analysis of the Run in progress

• Integration of the data from the Run in progress

• Initiation of a new Run

• Utilities functions, including calibrating pH probe, gradient pumps, conductivity

• Manual mode functions

During a run, the following toolbar buttons activate the offline window:

• Browser button

The online and offline windows are distinguished as follows:

• Online: The BioLogic Duo-Flow icon in the upper left of the screen is green, and the title bar does
not indicate online.

• Offline: The BioLogic Duo-Flow icon in the upper left of the screen is yellow, and the title bar
indicates offline.

To change between the online and offline windows, you can use any of the following:

• Windows drop down menu: The online and offline windows are listed.

• Task bar: The Windows® taskbar lists the BioLogic Duo-Flow windows.

• Alt-Tab: Simultaneously hold down these two keys to list the open windows.
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7.4.3 Editing A Method During a Run

During a run, you may find you want to change some of the run parameters. The figure below shows how
this is handled by the system and some of the restrictions.

Figure 7-7. Editing during a Run

• During the first run of a method, you can pause the method and return to the Protocol screen to edit
steps that have not already been started. The method name will not change.

• Any run after the first can be paused and then edited, except runs in queue which cannot be edited.
You will first be asked to rename the method (or accept the default new name) when the Edit
Protocol button is clicked. This is to ensure the integrity of the database in terms of which Method
Protocol particular runs are tied to.

For example, assume you make three runs under a method named “Ion-exchange UNO Q1.” During
the fourth run, you may decide to pause the run, and enter the Protocol screen to increase the
length of the salt gradient. In this case, you will first be prompted to rename the Method (e.g., Ion-
exchange UNO Q1 Rev. 1) before proceeding with the edit.

Upon completion of the run, the database of Methods and Runs will show three runs associated with
the method “Ion-exchange UNO Q1” and one run associated with the method “Ion-exchange UNO
Q1 Rev. 1.”

• A fraction collection scheme is editable, but it cannot be added to a Protocol once a run has been
started. In such cases, you should abort the run and s elect Edit the Method.

• A currently programmed fraction collection scheme may be edited during a run, but note that
changing the fraction size of a “Collect All” scheme will first require selection of  “Collection
Windows.” This is because the editing process effectively turns the initial “Collect All” scheme into
the “first” collection window.

Method

Edit prior
to run

Edit during or after any run after the first run

Edit during
the first run

Setup
Protocol
(Steps)

Method
Name Run 1

Run 2

Run 3
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Figure 7-8. Protocol Screen during a Run
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7.4.4 Run Notebook 

Use the Run Notebook screen to maintain any information you want regarding the run. It contains fields for
description of the sample, the column, the operator, the buffer(s), flow rates, gradients, chart speed, fraction
size, and any other information you might want to enter.

Figure 7-9. Run Notebook Screen

7.4.5 Run Log 

The Run Log screen details the time and order of the execution of each step, error, and/or event of the run.
This information cannot be edited. It is possible, although not recommended, to turn off the Run Log by
deselecting its checkbox in the Edit User Preferences window, available from the Options menu.

Figure 7-10. Run Log Screen

Event Log for <<run name>>

Description:
Author: Date: <<Time and Date>>

User Name: <<name>>

Project Name: <<name>>

Method Name: <<name>>

Run Name: <<name>>

Run Operator: <<name>>

 <<run description>>

Close

Run Notebook

Method Name:
Method Description:

Run Name:

Method 1
Date
Run 1

Sample:

Column:

Operator:

Buffer A:

Buffer B:

Flow Rate:

Gradient:

Chart Speed:

Fraction Size:

Run Description:

Run Notes:

OK

Cancel
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7.5 POST-RUN 

The Post-Run screen enables peak annotation (“tagging”) and data export. To enter the Post-Run screen,
open a Run file in the Browser screen, or when a run is finished choose PostRun from the toolbar. Two
chromatograms are viewed: the main chromatogram in the lower large window and the reference
chromatogram in the upper right window. In the upper reference chromatogram, use the sliding sidebar to
make scaling adjustment.

Note: The Values at Cursor window in the upper left corner will list fewer traces if you are not using the
QuadTec multiwavelength detector.

Figure 7-11. Post-Run Screen

7.5.1 Resizing

The main chromatogram shows the current “Zoom” region. To resize the image (or “zoom in” to a particular
region of the chromatogram), either change the axes scale in the reference chromatogram, or use the
“rubber band” controls on either chromatogram. To use the rubber band controls, click and hold the left
mouse button. Drag it across the chromatogram region. Release the mouse button and the main
chromatogram will be resized. Click on the Full View button in the toolbar to return to normal view.

7.5.2 Chromatogram Information (Values at Cursor)

The top left corner of the PostRun screen contains information about the chromatogram. The position of the
vertical bar within the main chromatogram dictates the displayed information. Run time, the absorbance
(AU) and conductivity (mS/cm) values, gradient progression (%B), and the current tagging trace are
displayed for the peak selected by panning the vertical bar across the chromatogram. To view the vertical
bar, move the cursor inside the main chromatogram.
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7.5.3 Annotating (“tagging”) the Chromatogram

Tags can be placed on any trace. To assign tags to a trace, and to view all assigned tags and their data, use
the Post-Run Tags window, shown below. To display the Post-Run Tags window, click once on the Tags
button in the toolbar or from the Edit drop down menu, select Tag and Trace Options.

In the Post-Run Tags window, select a trace by clicking on an Active Trace radio button. Trace visibility and
tag visibility can also be selected from this box. Tag styles are specified in the upper right box. Peaks can
be annotated with a sequential tag number (1,2...), a user-defined name (user tag name), with the trace
value, or the run time.

Figure 7-12. Post-Run Tags for Standard UV Detector
(Note: Additional Traces will be shown when the QuadTec Detector is being used.)

To change a tag name in the Post-Run screen chromatogram, move the cursor over the tag and note that
the cursor changes. Double click on the tag and in the window that appears, enter the tag name. To
deselect a tag, highlight the undesired tag and press DelTag from the button bar. To remove all tags, select
“Delete all tags” from the Edit drop-down menu.
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7.5.4 Entering Activity Data

The Activity Trace Editor permits data collected by a separate offline method to be included with data
collected by the Duo-Flow method. For example, if fractions collected by the Duo-Flow are also analyzed by
an ELISA method or for radioactivity, CPM, or DPM, the data collected by these assays can be entered into
the Activity Trace Editor and a trace will appear on screen reflecting the activity for each fraction.

From the Browser screen, select the run for which you wish to enter the post-run activity data. From the
post-run screen that is displayed:

1. Select the Activity icon from the toolbar. A box will appear listing each fraction collected in the
opened run. (See Figure 7-13.)  

2. Enter values for each fraction and enter the desired units.

3. The activity values entered will appear along with the chromatogram data that appears in the upper
left hand corner as the cross hatch is moved across each peak and fraction. (See Figure 7-14.)  

Figure 7-13. Activity Trace Editor
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Figure 7-14. Activity Trace
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7.5.5 Exporting Chromatogram Data to other Software Applications

To transfer data, go to the Post-Run screen of the desired run. Select Export Data from the File drop-down
menu (See Figure 7-15, Export Data Setup screen). From this screen, choose the run time and the data
trace(s) that will be exported. Although data is collected at a rate of five points per second, it can be
exported at a user-defined rate. Data is exported in an ASCII.TXT file format. The file name is user-defined
and can be saved anywhere on the hard drive. Note that the default file is called "Export" and is located in
the following directory, "Biologic/data/export". When importing the data into Excel, choose comma delimited.

Figure 7-15. Export Data Setup Screen
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7.5.5 Exporting Chromatogram Images

Chromatographic images can be exported into other applications, such as word processing programs.
Before transferring an image, modify the chromatogram in the PostRun screen since changes cannot be
made to the file once it is transferred out of the BioLogic Duo-Flow program. The image in the main
chromatogram will be the exported image.

Select Export Chromatogram Image from the File drop-down menu (see Figure 7-16). The image is
exported as an Enhanced Meta File (*.emf) format. In general, the Enhanced Meta File format is used for
transfer into a Windows-based application.

Alternatively, a chromatogram can be copied to the Windows clipboard and pasted into another Windows
program. Choose “Copy zoom Chromatogram to clipboard” from the Edit drop-down menu.

Figure 7-16. Exporting a Chromatographic Image
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